
 

UNIT-III 

BASIC OF 3D STUDIO MAX: HARDWARE & SOFTWARE REQUIREMENTS 

Autodesk 3ds Max 2021 software is supported on the following 64-bit operating 
systems and at a minimum, requires a system with the following 64-bit hardware: 

Software 

Operating 

System 

64-bit Microsoft® Windows® 10. See Autodesk's Product Support 
Lifecycle for support information. 

Browser 

Autodesk recommends the latest version of the following web 
browsers for access to online supplemental content: 

 Microsoft® Edge 

 Google Chrome™ 

 Microsoft® Internet Explorer® 

 Mozilla® Firefox® 

 

Hardware 

CPU 
64-bit Intel® or AMD® multi-core processor with SSE4.2 instruction 

set 

Graphics 

Hardware 

Refer to 3ds Max Certified Hardware for a detailed list of 
recommended systems and graphics cards 

RAM 4 GB of RAM minimum (8 GB or more recommended) 

Disk Space 9 GB of free disk space for install 

Pointing 

Device 
Three-button mouse 

 

LIVING IN A 3D WORLD, BUILDING VERTICAL EDGES AND FACES 

What Are Three Dimensional Shapes? 

In geometry, a three dimensional shape can be defined as a solid figure or an object 
or shape that has three dimensions— length, width, and height. Unlike two 
dimensional shapes, three-dimensional shapes have height, which is the same as 
thickness or depth. Three dimensional is also written as 3D and hence, these figures 
are commonly called 3D shapes too. All three dimensional figures occupy space, 
which is measured in terms of volume. 
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In 3D shapes, 3D refers to three-dimensionality. Dimensions can usually be thought 
of as measurements in a direction. Length, width, and depth can be 
considered dimensions. 

History of 3D Shapes 

All 3D shapes have three measurements: length, width, and height. Shapes look 
different from different directions. All 2D shapes are only measured by their length 
and width. Aristotle said that 2D shapes are lines and not figures or bodies. They are 
always described as extensions of lines or areas bounded by lines. Conversely, 3D 
shapes have volume. 

By convention, the first three dimensions are represented as spatial dimensions x-y-
z. Width, height, and depth are their respective names.  

Examples of Three Dimensional Shapes 

A cube, rectangular prism, sphere, cone, and cylinder are the basic three dimensional 
figures we see around us.  

 

Real-life Examples of Three Dimensional Shapes 

3D shapes can be seen all around us. We can see a cube in a Rubik’s Cube and a die, 
a rectangular prism in a book and a box, a sphere in a globe and a ball, a cone in a 
carrot and an ice cream cone, and a cylinder in a bucket and a barrel around us.  

Some real-life examples of 3D shapes are listed below: 

1. Cone: Traffic cones and birthday caps are cone-shaped. 
2. Triangular prism: A tent is the shape of a triangular prism. 
3. Square pyramid: The pyramid of Giza in Egypt is the shape of a square 

pyramid. 
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4. Rectangular prism: Boxes such as shoe boxes and cereal boxes are shaped like 
rectangular prisms.  

 

Attributes of Three Dimensional Shapes 

There are three attributes of a three dimensional figure: face, edge, and vertex. Let’s 
understand three dimensional shapes and their properties in detail. 

 
Face: Each single surface, flat or curved, of the 3D figure is called its face. 

https://www.splashlearn.com/math-vocabulary/geometry/face
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Edge: The line, where two faces of the 3D figures meet, is called its edge. 

Vertex: Each corner, where three faces of 3D figures meet, is called its vertex. 
Vertices are the plural of the vertex. 

List of Three Dimensional Shapes 
Here’s a list of the names of three dimensional shapes with their pictures, and 
attributes. 
Sphere 
All the points on a sphere are at the same distance from its center. The Earth is like 
that in some ways, except for one: when you look at it from far away, it looks like a 
sphere, but when you look at it from up close, it is not truly round. A sphere has 
several characteristics: 

 It is perfectly symmetrical and shaped just like a ball. 
 It also has length besides radius, diameter, circumference, volume, and area. 
 The distance from the center to every point on the surface of a sphere is equal. 
 No edges or vertices are found on its one face. 
 Since it does not have a flat face, it is not a polyhedron. 

Cube and Cuboid 

A cube and a cuboid are both big blocks. The difference between them is that a cube 
has square faces, while a cuboid has rectangular faces. 

Cylinder 

A cylinder has two circular faces on both its ends and one curved surface along its 
length. It has height and radius. A cylinder’s height is perpendicular to its surface, 
from top to bottom. The following are some fundamental characteristics of cylinders: 

 The face of a cylinder is curved. 
 From the bottom to the top, its shape remains the same. 
 Two identical ends shape the object’s three-dimensional form. The ends can 

be round or oval. 
 A right cylinder has the centers of its circular bases along the same line, while 

an oblique cylinder has the centers of its bases along different lines. 

https://www.splashlearn.com/math-vocabulary/geometry/area
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Formula of Three Dimensional Shapes 



 

Net of Three Dimensional Shapes 

A net is a pattern made when the surface of a 3D figure is laid out flat, showing each 
face of the figure. 

3D figures can have more than one net pattern. A few 3D shapes names and their 
nets are shown below: 



 
Fun Facts: 
All three dimensional shapes are made up of two dimensional shapes. 
Difference between 2D Shapes and 3D Shapes 
Let’s differentiate between 2D and 3D shapes by understanding two dimensional 
and three dimensional shapes and their properties. 

 

 

Solved Examples 



Example 1: Which of the following is a 3D shape? 

Cone Square Sphere Cuboid Cylinder Parallelogram 

Solution: 

Cone Sphere Cuboid Cylinder 

Example 2: State whether the following are true or false. 

1. A three-dimensional shape has 3 dimensions. 
2. Three-dimensional shapes are also called flat shapes. 
3. Three-dimensional shapes occupy space. 
4. All three-dimensional shapes have flat faces. 

Solution: 

1. True 
2. False. Three-dimensional shapes are also called solid shapes. 
3. True 
4. False. Sphere is a three-dimensional shape with no flat face. 

Example 3: Complete the table with attributes of the 3D shapes listed. 

 
Solution: 



 
Example 4: Match the object with its shape. 

 
Solution: 

1. – (iii) 
2. – (i) 
3. – (iv) 
4. – (ii) 

Example 5: Calculate the surface area of a cuboid with a width of 4 units, length of 
3 units, and height of 5 units.  

Solution: 

Given, the cuboid has three units of length, four units of width, and five units of 
height. 

Surface area of the cuboid =2×(lw+wh+lh) square units 



=2×(lw+wh+lh) 

=2[(3×4)+(4×5)+(3×5)] 

=2(12+20+15) 

=2(47) 

=94 square units 

Therefore, the surface area of the given cuboid is 94 square units. 

Example 6: Jane likes to drink milk from a cylinder-shaped glass. Her glass has 15 
units of height and 3 units of base radius. How much milk can she fill in the 
glass? 

Solution: 

Given that the height of the glass is 15 units, and the radius of the base is 3 units. 

Using the formula for the volume of a cylinder, we can find the volume of the glass. 

The volume of the glass, V=��2h 

=�(3)2(15) 

=135�   

=424.11in2 

Therefore, Jane can fill approximately 424 cubic units of milk in her glass. 
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Introduction to 3D animation 

3D animation refers to the process of taking digital objects and making them come to 

life by creating the illusion that they’re moving through a three-dimensional space. These 

computer-generated objects appear on a two-dimensional screen, but they’re crafted to 

mimic the principles of a 3D world. 

Ways to use 3D animation 

3D animation first got its start in gaming, TV shows, and movies. However, it’s 

become widely used beyond these contexts. From corporate ad campaigns to 

architectural modeling and medical research, 3D animation is used across many 

industries and for diverse purposes. Here’s an overview of common uses of 3D 

animation today. 

Television and movies 

3D animation is often used for character animation in TV and movies. The 

technique can make characters seem more lifelike, enhancing the emotional 

connection viewers establish with them. A 3D animated character is more vivid 

and engaging, almost like playing with a toy. 

Gaming 

3D animation can also give a more lifelike feeling to video games, intensifying 

the action for the player. When you’re battling an enemy or racing through an 

obstacle course, having the 3D sensation can make for a far more thrilling 

experience. 3D animation can also be used with virtual reality and augmented 

reality special effects, giving the player the sense that they’re inside the world in 

real-time. 



Company presentations 

The days of boring PowerPoint presentations are long gone. Presentations with 

3D animated features help draw the audience in and command their attention 

for the entirety of a presentation.  

Marketing 

3D animation can also prove valuable in marketing. For example, a marketer 

might use this technique to show off all the product’s features as they would 

appear in real life. Audiences can get a better sense of what the goods look like. 

Brands can also use 3D animation to showcase products through tutorials or 

demos. 

Architecture and design 

3D animation is also handy for creating life-like renderings of houses and 

buildings before they’re constructed. Combined with VR and AR tools, 

architects can even step inside and walk through their designs. This is also 

useful for interior decorating, letting designers get a concrete idea of what a 

room will look like. These 3D rendering examples rounded up by LCP360 show 

what this technology can accomplish. 

Prototyping 

3D animation can also be combined with another cutting-edge tool, 3D printing, 

to create product prototypes at a low cost. From engineering firms to medical 

technology companies, businesses can save money on raw materials as well as 

time and manpower by visualizing and crafting a low-cost prototype. They can 

then tweak their goods based on the prototype before developing a finalized 

product. 

Medicine 

Medical professionals can use 3D animation for teaching, to show detailed 

imagery of the human body, and even digitally demonstrate medical techniques. 

For areas that are hard to experiment in, like surgery, this can be invaluable. 

Medical animation can also be used to communicate with patients—for example, 

by showing them what to expect from a procedure.  

Simulations 

https://www.lcp360.com/blog/the-best-3d-rendering-examples


Finally, 3D animation can be used in simulations across an array of fields. For 

example, 3D videos can be used to help enhance employee training. A single 3D 

animated video can be accessed by workers whenever they need it, minimizing 

the need for costly and confusing mass training sessions.  

3D animation process 

3D techniques can take an animated figure that appears on a two-dimensional 

screen and not only can they make that object look three-dimensional but they 

can also make it look like it’s moving through a three-dimensional space. A 

skilled animation will have you reaching out and expecting to touch a 3D object, 

only to face a flat-screen. How is 3D animation created? Here’s an overview of 

how to 3D animate for beginners. 

1. Modeling 

In the modeling phase, animators create 3D objects that will serve as the basis 

for animation. This kind of animation is achieved by using a modeling tool. A 

3D mesh is made from a simple object, called a primitive, which is then shaped 

and refined to the desired figure. The 3D models are then given details like 

color and texture. This is followed by a process known as rigging, which sets up 

a skeleton for the animation character that will allow it to move. 

2. Layout and animation 

Only once the above steps are complete will a 3D animator move on to the 

actual animation process. At this point, they can take a 3D object and make it 

move. There are different ways to do this, from using keyframes—moving the 

object on a frame-by-frame basis—to using motion capture data. 

3. Rendering 

Once the animation is perfected, along with the lighting and camera angles, the 

animator can move on to rendering. In this process, the graphic images that 

have been designed are actually created and exported. The final render of the 

3D character will be tweaked according to light and shadows, reflections, 

transparency, and other details. 

What are the benefits of 3D animation? 

https://www.upwork.com/resources/3d-rigging-animation/


3D animation has shown its utility in an array of contexts, from advertising to 

medical research, architectural design, and beyond. Why are so many industries 

embracing this cutting-edge graphic technique? These are some of the distinct 

benefits offered by 3D animation. 

User engagement 

By creating more lifelike and interesting imagery, 3D animation can boost user 

engagement. This applies across various contexts—from video games to 

marketing and company presentations—by drawing the viewer in and keeping 

them captivated, and great animation ups the odds that the viewer will stay 

alert and engaged. 

Larger audience attraction 

3D animation appeals to a broad range of audiences. It can also be used to target 

large crowds of people. Placing a 3D animation on a giant screen can be a great 

way to draw the attention of a big group. For example, a digital billboard with 

3D animation can make a big splash in a crowded space. 

Communicates effectively 

It’s possible to create clearer images that provide a real-world impression by 

using 3D animation. This can enhance communication, eliminating confusion—

for example, as to what a product might look like in a 360-degree view. Thanks 

to its visual impact, 3D animation can also boost emotional connection, further 

enhancing communication. 

Excellent branding tool 

3D animation allows businesses to better convey their brand by providing more 

detailed insights into their products, services, and overall vision. Companies 

that use this kind of cutting-edge technology can also establish themselves as a 

more modern and forward-thinking brand in the eyes of consumers. 

 
 
 
 
 
 
 
 



Introduction to space 
Introduction:  
Third Dimension (3D) computer graphics is ‘2 dimensional portrayal of the 
simulated 3D world’. It is the virtual world we see around us.  
Use of 3D animation software can be termed as video capturing of the real world 
which is full of 3D objects and then generating the series of 2D images rapidly to 
simulate motion in the form of output.  
While transferring 2D image in third dimension; a z-coordinate axis has to be added 
along with the default ones i.e. x-axis and y-axis. In addition to this, we just don’t 
create objects in 3D; but we have to generate the 2D images of the 3D scene which 
will resemble the 3D objects.  
Example: An arrangement of a 3D Coordinate axis.  
Image axes  
It is not difficult to recognize the above image of three arrows in different directions 
in space. They are just three lines on a 2d surface formed using a thin cylinder and a 
cone. 

 
Co-Ordinate System:  
Our first job is to get familiarize with 3D coordinate system. In 3D the x and y axis 
are arranged in alpine called the xy - plane with z-axis perpendicular to it. But, here 
the z-axis is divided into two sections by the origin (0, 0, 0). One of the divisions 
displays the positive z-axis which we have to decide.  
The traditional coordinate system recognize xy plane with the screen. The x-axis 
points towards right in positive direction and the y-axis towards positive upwards. 
The z-axis is perpendicular to the screen which is the positive direction and the 
negative into the screen. This is a right-handed coordinate system.  



 
If you curl the fingers of your right hand in the direction from the positive x-axis to 
the positive y-axis, then your thumb points in the direction of the positive y-axis. 
This is only the traditional coordinate system. For drawing you use a different 
coordinate system.  
There are quite a few co-ordinating systems and these are associated with chain of 
transforms to one another. The co-ordinates which we use to create an object in 3D 
world are called the Object coordinates. 
 
In a particular scene; the scale, rotation and position of an object can be altered. The 
object coordinate system is suitable for the object that is being created. The 
coordinates which is used to create the complete scene with objects is called the 
World coordinates. After creating the scene the output can be taken in the form of an 
image. 
 
Objects of 3D Animation Objects are made up of the following components:  
• Vertices  
• Edge (Line, Spline or Segment)  
• Polygon 
 
Vertices:  
These are the point locations in space with no dimensions, but make the complex 
objects when grouped with other points. 

 
 



Edge (Line, Spline or Segment): An Edge is the set of two points connected by a 2 
dimensional line. 

 
 
Polygon:  
Three or more edges that define a surface is called Polygon.  

 
 
 
 
 

Architectural rendering is the process of creating images of the designs we intend to 

build. It is the current trend of communication of our design to the client. It is a form 

of visualization which helps you and as well as your client to best understand the 

place and the design. Architectural renders become crucial in the architectural 

profession today. And so, it is vital to take the best renders and present them in the 

best way. Here are some of the tips for the best and faster rendering in 3ds max and 

SketchUp. 

1.  Optimize the models 

If you don’t see it, hide it. It is the first and the foremost rule for a fast rendering. If an 

object becomes invisible in a scene, then you may turn off the object or the layers of 

the object. It will increase the efficiency, and so the rendering time of the image. 



Also, you can optimize models based on the distance to the camera and the level of 

detail required. For example, if there are more cars and they are going to be far away, 

you can use simpler models and optimize them using optimizing modifiers in 3ds 

max and SketchUp. 

2.  Reduce polycount 

Photo Source: https://forums.autodesk.com/t5/3ds-max-modeling/reduce-polygon-count-in-a-

selected-area-of-a-mesh-model 

The more polygons you have in your scene, the longer the time it takes to render. 

Models in 3ds max and Sketchup, with lesser polygons, increase the render time and 

when the model becomes heavy, slower will be the render speed. Hence, it becomes 

crucial to use models with lesser polygons, and you can reduce the polygons through 

Skimp or Transmuter. Consider greater polygon models for objects that are nearer to 

the camera and lesser polygon models for those which are far away in the scene. 

Reducing the polycount of the objects would increase the efficiency and the render 

time by up to 5% for the high poly models. 

3.  Use proxies 



Photo Source: https://forums.sketchup.com/t/lost-material-when-using-proxy-in-vray-4-

2/137533 

If you cannot avoid so many complex models in your renders, the better option for a 

faster render would be the use of proxies. With proxies, you can reduce the 

polycounts of the models and so the render takes place faster in v ray versions of 

both 3ds max and Sketchup. Turning objects into proxies also reduces the file size of 

the models and it would be a lot more efficient for bigger projects at a city scale or a 

neighborhood scale. You shall use the Chaos cosmos library to download proxy 

models for your render. And do not forget to purge the original objects after turning 

them into proxies. 

4.  Select materials properly 

Many things, such as wood floors, walls, and cabinets, reflect light. Objects in the 

foreground with visible reflections and objects which reflect lights will look much 

better if you make them reflective. But reflective objects which don’t have anything 

specific to reflect will just slow down your rendering processing reflection which 

doesn’t really affect the final image. For example, using white-colored materials in 

the render obviously increases the render time as white is reflective and so, you can 

choose off-white material which reduces the render time significantly and retains the 

result at the same time. 

5.  Reduce texture resolution 



 
 

Photo Source: https://garagefarm.net/blog/how-displacement-maps-work-and-how-to-

optimize-them-in-v-ray-part-1 

As the model with lesser polycount increases the render speed, is the resolution of 

the textures. You can use 1k to 2k resolution textures for the models which are far 

away from the camera and the 4k resolution for the objects that are close enough. 

The math behind the digital image seems very complex at first glance, but you will 

come to see it as very plain and logical. 

The equation is simple: Raw image size = Horizontal resolution x Vertical 

resolution (in pixels) x Number of channels x Color depth (Number of bits per 

channel) 

6.  Minimize using displacement maps 

You know that using displacement maps in Sketchup as well as 3ds max makes the 

renders smooth and beautiful. But it does not mean that you should use 

displacement maps for all materials, because it slows down your render. Consider 

using material maps wherever necessary. For example, you can use displacement 

maps for materials such as brick, whereas for the seamless materials like wood, you 

can use bump maps, which will be efficient in reducing the render time while 

retaining the quality. 



Photo Source: 

https://www.yankodesign.com/2019/04/13/creating-realistic-textures-with-displacement-

maps-in-keyshot-8/ 

7.  Optimize lighting 

Photo Source: https://www.youtube.com/watch?v=-IFhiexC-B0 

Lighting is the most crucial part of the renders. It is important to know to optimize 

the lighting of the scene to make the render more efficient. If you want your render 

to be too bright, then you have to wait for a longer time to get your render. Instead, 

render a darker image and use exposure to brighten the image, which reduces the 

time as well as gets back the brightness you need. Also, minimize the light sources in 

your renders and get rid of the lights which do not affect the image. 

 



 
 
 
 
 
The Max Interface 
 
The 3ds Max interface comprises controls, status information, and viewports, where 
you work and view your scene. 

One of the most important aspect of using 3ds Max is its versatility. Many program 
functions are available from multiple interface elements. For example, you can open 
Track View for animation control from the Main toolbar as well as the Graph Editors 
menu, but the easiest way to get to a specific object's track in Track View is to right-
click the object and then choose Track View Selected from the Quad menu. 

You can customize the user interface in a variety of ways: by adding keyboard 
shortcuts, moving toolbars and command panels around, creating new toolbars and 
buttons, and even recording scripts into toolbar buttons. 

The user interface is high DPI aware, and ensures that you have the optimal 
experience with your display hardware. 

Note: Some images of the user interface (icons, toolbars, etc.) found within 3ds Max 
Help may be of older versions of the software. 

 

 
 
 
 
 



The main toolbar provides quick access to tools and dialogs for many of the most common tasks 

in 3ds Max. 

 

The main toolbar, split in two for this illustration 

The Main toolbar is visible by default when first launching 3ds Max. However, if you close it and 
want to reopen it, you can open it from the Show UI submenu. 
The main toolbar can be floated and docked in a different position on the interface by clicking 
and dragging the handle to the left of the toolbar. You can also make the Main toolbar modular, 
by selecting the Main Toolbar-Modular workspace from the Workspace Selector. Once modular, 
you can float and dock groups of tools to your liking. 

Tip: If the main toolbar is wider than the 3ds Max window (or even than your computer screen), 

you can pan it by dragging a gray area of the toolbar, such as below the drop-down lists. 

 Undo/Redo 

 Select and Link 

 Unlink Selection 

 Bind to Space Warp 

 Selection Filter List 

 Select Object 

 Select by Name 
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https://knowledge.autodesk.com/support/3ds-max/getting-started/caas/CloudHelp/cloudhelp/2021/ENU/3DSMax-Basics/files/GUID-0E53BB0B-8F4A-4C32-8968-6D5226ECE8FF-htm.html


 Selection Region flyout 

 Window/Crossing Selection Toggle 

 Select and Move 

 Select and Rotate 

 Select and Scale flyout 
Note: Right-clicking the Move, Rotate, or Scale button opens the Transform Type-In dialog. 

 Select and Place flyout 
Note: Right-clicking the Select And Place or Select And Rotate button opens the Placement 

Settings dialog, also described in Select and Place. 

 Reference Coordinate System 

 Use Center flyout 

 Select and Manipulate 
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 Keyboard Shortcut Override Toggle 
 

 2D Snap, 2.5D Snap, 3D Snap flyout 
 

 Angle Snap Toggle 

 Percent Snap Toggle 

 Spinner Snap Toggle 

 Edit Named Selection Sets 
 

 Named Selection Sets 
 

 Mirror 
 

Align flyout 
 

 Toggle Scene Explorer 
 

 Toggle Layer Explorer 
 

 Toggle Ribbon 
 

 Curve Editor (Open) 
 

 Schematic View (Open) 
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 Material Editor flyout 
 

 Render Setup 
 

 Rendered Frame Window 
 

Render flyout 
 

 
Accessing commands in the menu bar 
 
The menu bar is located directly under the main window’s title bar. The title of each 
menu indicates the purpose of the commands on the menu. 

Menu systems 

3ds Max includes two menu systems. The default menu is the one you see on the 
initial product launch; it follows standard Windows conventions. Alternatively, you 
can use the Alt menu, which organizes things slightly different. The Alt menu is part 
of the Alt Menu and Toolbar, and Modular-mini workspaces. 

The optional Alt menu system features improved organization of the default layout, 
configurable display, detailed tooltips that link to relevant help topics, drag-and-
drop menu categories, and the ability to search for menu commands from the 
keyboard. 

To access the Alt menus, open the Workspaces selector and choose one of the 
workspaces with Alt menus. 

Common menu features 

The following is a list of functions common to both menu systems: 

 To open a menu from the menu bar, click its name, such as Edit or Customize. 
The menu opens as a list of commands and submenus or panels. To open a 
submenu, point at its name. To invoke a command, click its name. 
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Tip: While a menu is open, you can open any other menu simply by pointing to 

it with the mouse; no further clicking is necessary. 

 As an alternative to using a mouse or other pointing device, most menu names 
includes an underlined character when you hold down the Alt key. 
Pressing Alt + that character key opens the menu, unless that particular key 
combination is assigned to a keyboard shortcut. 

 Some commands in the open menu have an underlined character as well. While 
the menu is open, pressing that character key invokes the command. While 
navigating menus with the keyboard, you can also use the arrow keys to move 
the highlighting and the Enter key to activate a command. 

 An ellipsis (…) after a command name indicates that invoking the command 
opens a dialog. 

 A right-pointing triangle after a command name indicates that pointing at the 
name will cause a submenu to open. 

 If a command has a keyboard shortcut, the menu shows it to the right of the 
command name. 

 If a command has an icon, it displays to the left of the command name. 

 

In the Rendering menu, Render Setup has an icon, an ellipsis, and a keyboard 
shortcut. 

 If the 3ds Max window isn't wide enough to display all menu titles, a scroll bar 
appears just below the menu bar. To access hidden parts of the menu bar, drag 
the scroll bar or click the arrows at the left and right ends. 

 To view a tooltip that provides a brief description of a menu command, hover the 
mouse pointer over the command briefly. While a tooltip is visible, you can open 
the help to a topic about the command by pressing function key F1. 

 To float a menu panel or submenu, drag its title bar away from the menu in any 
direction. To dock a floating panel with another, drag it over the other panel. 
Then, when a blue line appears, indicating where the panel will dock, release the 
mouse button. Depending on where you position the panel while dragging, you 
can dock it above or below the host panel. 



Note: A floating panel also remains in its original location on the menu. Also, all 

floating panels are saved upon exiting the program and restored upon restarting. 

o To move a floating panel or panel group, drag the bar at the top of the group. 

o To restore a floating panel group to the menus, click the icon at the right end of 
the bar at the top of the group. 

o When a command name is too long to fit in the allotted space, the center of the 
name is elided. The beginning and end of the name are shown, and the middle 
part is replaced by an ellipsis (...). 

Global menu search 

To search the entire 3ds Max system (menus and actions) for a particular command, 
press the X key with no menus open. This opens a small Search All Actions dialog at 
the mouse cursor location. As you enter the search text, a drop-down list opens from 
the search dialog showing matching actions. To choose an action, click its name. To 
clear the search field, click the X icon at the right end of the search box. To exit the 
search, choose a command, click outside the search interface, or press Esc. 

 

Entering text in the global search field shows all matching actions. 

This function is also available as Search 3ds Max Commands on the Help panel of 
the Help menu in the Alt menu system. 

 

Command Panel 

The command panel comprises six user-interface panels that give you access 

to most of the modeling features of 3ds Max, as well as some animation features, 

display choices, and miscellaneous utilities. Only one panel is visible at a time. To 

display a different panel, you click its tab at the top of the command panel. 

These are the panels: 



  Create panel 

Contains controls for creating objects: geometry, cameras, lights, and so on. 

  Modify panel 

Contains controls for applying modifiers to objects and editing editable objects 

such as meshes and patches. 

  Hierarchy panel 

Contains controls for managing links in a hierarchy, joints, and inverse 

kinematics. 

  Motion panel 

Contains controls for animation controllers and trajectories. 

  Display panel 

Contains controls that let you hide and unhide objects, along with other display 

options 

  Utilities panel 

Contains miscellaneous utility programs. 

By default, the command panel appears at the right of the 3ds Max window. You can 

"dock" it along other edges of 3ds Max window, or make it a floating panel. See 

Customizing 3ds Max. 

Topics in this section 

 Object Name and Wireframe Color 

The name and color fields appear at the top of all command panels other than the 

Create panel. On the Create panel, the fields are contained in a rollout. You can 

change an object's name or color from any of these locations. 

 Create Panel 

The Create panel provides the controls for creating objects. This is the first step in 

building a new scene in 3ds Max. 

 About the Modify Panel 
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 Hierarchy Panel 

The Hierarchy panel provides access to tools to adjust the hierarchical linkage 

between objects. 

 Motion Panel 

The Motion panel provides tools to adjust the motion of the selected object. 

 Display Panel 

The Display panel provides access to tools that control the display of objects in 

the scene. 

 Utilities Panel 

The Utilities panel gives you access to a variety of useful tools. 

 

Configuring Viewports 

 

You can customize your viewport layout, viewport rendering, display performance, 

as well as how objects are displayed by changing general configuration settings. 

Active Viewport Borders 

When multiple viewports are visible, one viewport, marked with a highlighted 

border, is always active. This is where commands and other actions take effect. For 

example, press Alt+W to toggle between maximizing the active viewport and 

viewing all available viewports. 

Only one viewport at a time can be active. Other viewports are for observation only; 

unless disabled, they simultaneously track actions taken in the active viewport. 

When Auto Key or Set Key is on, the active viewport border changes to red. 

In general, a viewport becomes active as you work in it. You can move an object in 

one viewport, and then drag the same object in another viewport to continue the 

move. To activate a viewport without changing the selection, right-click it. If you 

left-click a viewport, the viewport is activated and whatever you click is selected, or, 

if you click an empty area, everything is deselected. You can restore previous 

selections with Undo (Ctrl+Z). 

Switching Viewports When Maximized 

https://knowledge.autodesk.com/support/3ds-max/getting-started/caas/CloudHelp/cloudhelp/2021/ENU/3DSMax-Basics/files/GUID-2C0E3C6A-7E0B-46A7-BB64-C9523E677A2F-htm.html
https://knowledge.autodesk.com/support/3ds-max/getting-started/caas/CloudHelp/cloudhelp/2021/ENU/3DSMax-Basics/files/GUID-E17E5B6B-8915-47D5-95B0-C143D7D0DD92-htm.html
https://knowledge.autodesk.com/support/3ds-max/getting-started/caas/CloudHelp/cloudhelp/2021/ENU/3DSMax-Basics/files/GUID-E6C6346B-436A-47B6-9952-43815529CCA5-htm.html
https://knowledge.autodesk.com/support/3ds-max/getting-started/caas/CloudHelp/cloudhelp/2021/ENU/3DSMax-Basics/files/GUID-6ED10DFF-77FC-42D1-884D-23EDF7C131FC-htm.html


When a multi-viewport layout is active and a viewport is maximized (toggle 

with Alt+W), you can switch to other viewports in the layout by first pressing and 

holding the Windows key (sometimes labeled "Start") and then pressing and 

releasing the Shift key. This opens an overlay interface for switching to a different 

viewport: 

 

Overlay interface for changing the maximized viewport 

At this point, the next available viewport is highlighted. You can change the 

highlighting by pressing Shift repeatedly; releasing the key at any time maximizes 

the highlighted viewport. Alternatively, point to the desired viewport and click the 

mouse button. 

Dynamic Resizing of Viewports 

You can resize the four viewports so they are of unequal proportions. To do so, drag 

the intersection of two, three, or four viewports, on the splitter bars. To return to the 

original layout, right-click an intersection of the dividing lines and choose Reset 

Layout from the right-click menu. 

The new viewport proportions are saved in the scene. However, changing 

the viewport layout always resets them. 

World-Space Tripod 
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The three-color world-space tripod is visible in the lower-left corner of each 

viewport. The colors correspond to the three axes of world space: red=X, green=Y, 

and blue=Z. The axes are labeled in these same colors. The tripod always refers to 

world space, regardless of the current reference coordinate system. 

The world-space tripod is on by default. To turn off this feature, see “To turn off the 

world-space tripod in all viewports” in the following procedures. 

Viewport Tooltips for Object Names 

When you’re working with objects in a viewport and pause the cursor over any 

unselected object, a tooltip appears with the name of that object. If you need to select 

something or link to something, wait until you see the tooltip to be sure you have 

selected the object you want. These tooltips are disabled when you work in sub-

object mode. 

Tooltips are on by default. To turn off this feature, see To turn off object name 

tooltips, below. For more information see Viewport Navigation and The 3ds Max 

Window. 

Procedures 

To make a viewport active, do one of the following: 

 Click any viewport. 

If you click an object in the viewport, it is selected. If you click a space where 

there are no objects, any selected objects are deselected. 

 Right-click any viewport. 

Right-clicking activates a viewport without changing the selection state of 

objects. (You can also do this by left-clicking the viewport label.) 

 Use Windows/Start + Shift to cycle among the current viewports. 

To switch between single and multiple viewports, do one of the following: 

 Activate the viewport to minimize or maximize, then, on the keyboard, 

press Alt+W. 

 Click Maximize Viewport Toggle in the lower-right corner of the 3ds 

Max window. 

To change viewports when one is maximized: 

1. Press and hold Windows/Start, then press and release Shift. 
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This opens the viewport-switching interface. 

2. If necessary, press Shift repeatedly to highlight the desired viewport, then release 

Windows/Start to maximize the highlighted viewport. 

Alternatively, simply click the desired viewport. 

To resize the viewports: 

1. Drag the intersection of two, three, or four viewports to move the horizontal and 

vertical splitter bars. 

2. Move the intersection to any new location. 

If you don't drag a corner, you can move the borders horizontally or vertically 

only. 

3. To reset the viewports, right-click an intersection and choose Reset Layout from 

the right-click menu. 

To change the number of viewports and their arrangement: 

1. In any viewport, click or right-click the General viewport label ([+]). 3ds 

Max opens the General viewport menu. Choose Configure. 

2. On the Viewport Configuration dialog, click the Layout tab. 

3. Choose a layout from the choices at the top of the dialog. 

4. Assign what each viewport will display in the lower window of the dialog by 

clicking or right-clicking a viewport representation and choosing from the right-

click menu. 

5. Click OK to make the change. 

To turn off the world-space tripod in all viewports: 

1. Choose Customize menu  Preferences to display the Preferences dialog. 

2. Click the Viewports tab. 

3. In the Viewport Parameters group, turn off Display World Axis. 

4. Click OK to make the change. 

To turn off object-name tooltips: 

1. Choose Customize menu  Preferences to display the Preferences dialog. 

2. Click the General tab. 

3. In the UI Display group, turn off Enable Viewport Tooltips. 

4. Click OK to make the change. 



Topics in this section 

 Setting Viewport Layout 

3ds Max defaults to a 2 x 2 arrangement of viewports. Thirteen other layouts are 

available, but the maximum number of viewports on the screen remains four. 

 Controlling Object Display 

You use the Display panel, layers, and Scene Explorer to control how objects are 

displayed in viewports, and to hide or freeze objects. This section covers usage of 

the Display panel controls. 

 Controlling Viewport Rendering 

You can choose from multiple options to display your scene. You can display 

objects as simple boxes, or render them with smooth shading and texture 

mapping. If you want, you can choose a different display method for each 

viewport. 

 Controlling Display Performance 

3ds Max contains controls to help you adjust display performance: the balance 

between quality and time in displaying objects. 

 

At the right end of the status bar are the buttons that control the display and navigation of the viewports. 

 

Some of the buttons change for camera and light viewports. The Field Of View button changes for 

Perspective viewports. 

The state of the navigation-button flyouts for all viewport types is saved in the [Performance] section of 

the Initialization file. 

Viewport Navigation Controls 

The navigation controls depend on the active viewport. Perspective, orthographic, 

camera, and light viewports all have specialized controls. The term “orthographic” 

refers to User viewports as well as viewports like Top, Front, and so on. The Zoom 

Extents All flyout and Maximize Viewport toggle, available in all viewports, are 

included with the perspective and orthographic viewport controls. 
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Many of these controls are modal, meaning the tool stays active for repeated use. 

The button highlights when on. To turn it off, press Esc, right-click in a viewport, or 

choose another tool. 

 2D Pan Zoom Mode 

Controls Available in All Viewports 

 Zoom Extents All, Zoom Extents All Selected 

 Maximize Viewport Toggle 

Perspective and Orthographic Viewport Controls 

 

 Zoom 

 Zoom All 

 Zoom Extents/Zoom Extents Selected 

  Field-of-View Button (Perspective) or Zoom Region 

 Pan View 

 Walk Through 

 Orbit, Orbit Selected, Orbit Sub-Object 

Camera Viewport Controls 

 

   Dolly Camera, Target, or Both 

 Perspective 

 Roll Camera 

 Field-of-View Button 

 Truck Camera 

 Walk Through 



 Orbit/Pan Camera 

Light Viewport Controls 

 

   Dolly Light, Target, or Both 

 Light Hotspot 

 Roll Light 

 Light Falloff 

 Truck Light 

 Orbit/Pan Light 

 

Viewport Label Menus 
Depending on the display driver selected, each viewport contains a series of up to five menus in the top left 

hand corner that control viewport display. 

 

The menus are: 

1. General 

2. Point-of-View (POV) 

3. Shading 

4. Per-View Preference (Nitrous only) 



5. 2D Pan Zoom (displayed only in 2D Pan Zoom mode) 

Click or right-click a menu to view its specific options. 

General Viewport Label Menu 
Products and versions covered  

By:  
Help 

Dec 01 2020In-product view   

SHARE 

  

ADD TO COLLECTION 

Use this menu to adjust general options for viewport display and configuration. 

 

General menu 

Note: This menu can be customized. For more information, see the Procedures section below. 

Interface 
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Maximize Viewport / Minimize Viewport 

Choose to maximize or minimize the viewport. 

Keyboard shortcut: Alt+W 

Active Viewport 

Choose the active viewport from a submenu list of currently visible viewports. 

Disable Viewport 

Prevents the viewport from updating with changes made in other viewports. While the disabled 

viewport is active, it behaves normally. However, when you change the scene in another viewport, 

the view in the disabled viewport does not change until you activate the viewport again. Use this 

control to speed up screen redraws when you are working on complex geometry. 

While a viewport is disabled, the text “<<Disabled>>” appears to the right of the viewport label 

menus. 

Keyboard shortcut: D 

Show Grids 

Toggles display of the home grid. Does not affect other grid display. 

Keyboard shortcut: G 

ViewCube 

Displays options for ViewCube display. 

SteeringWheels 

Displays options for SteeringWheels display. 

xView 



Displays the xView submenu. See Using xView for more information. 

Create Preview 

Displays the Create Preview submenu. 

Configure Viewports 

Displays the Viewport Configuration dialog. 

2D Pan Zoom Mode (Camera, Perspective, and Spotlight views with Nitrous display only) 

Choose this to turn on 2D Pan Zoom. While 2D Pan Zoom mode is active, a check mark appears 

next to this menu item, the  button becomes active, and the 2D Pan Zoom Viewport menu 

appears to the right of the other viewport label menus. 

 

This submenu provides options for displaying and using the ViewCube. 

Show the ViewCube 

Toggles display of the ViewCube. 

Keyboard shortcut: Alt+Ctrl+V 

Show for Active View 

Displays the ViewCube only in the active viewport. 

Show for All Views 

Displays the ViewCube in all viewports, whether active or not. 

Home 

Displays the Home view of the model. 

Keyboard shortcut: Alt+Ctrl+H 

Orthographic 
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Changes the view to an Orthographic view. 

Note: Choosing this option also changes the setting of the POV menu. 

Perspective 

Changes the view to a Perspective view. 

Note: Choosing this option also changes the setting of the POV menu. 

Set Current View as Home 

Defines the current view in this viewport as the Home view for the scene. 

Set Current View as Front 

Defines the current view as the Front view of the model. 

Note: You first need to orient the view using a view tool so that you are looking at what you 

consider to be the Front of the model with its Top facing upward and then choose Set Current 

View as Front. 

Reset Front 

Restores the Front view to the original Front view of the scene. 

Configure 

Displays the ViewCube panel of the Viewport Configuration dialog. 

SteeringWheels submenu 

 

This submenu provides options for displaying and using SteeringWheels. 

Toggle SteeringWheels 

Toggles SteeringWheels display for this viewport. 

Keyboard shortcut: Shift+W 

View Object Wheel 

Displays the View Object wheel. 



Tour Building Wheel 

Displays the Tour Building wheel. 

Full Navigation Wheel 

Displays the Full Navigation wheel. 

Mini View Object Wheel 

Displays the mini version of the View Object wheel. 

Mini Tour Building Wheel 

Displays the mini version of the Tour Building wheel. 

Mini Full Navigation Wheel 

Displays the mini version of the Full Navigation wheel. 

Configure 

Displays the SteeringWheels panel of the Viewport Configuration dialog. 

Create Preview submenu 

 

Capture Still Image 

Creates a snapshot of the active viewport in a Rendered Frame window , where you can save it as 

an image file. 

Create Preview Animation 

Displays the Make Preview dialog, enabling you to create an AVI file or custom file type preview 

of the animation in the current viewport. 

Play Preview Animation 

Displays the Windows-standard Media Player to view the current preview animation. 

Save Preview Animation As 

Saves the _scene.avi preview animation under another filename. 

Float Viewport submenu 



 

Floating Viewport - 1 (2,3) 

Opens a floating viewport window. The window functions just as the regular viewport and is fully 

configurable. The viewport is not dockable, but can be moved for use on another monitor if your 

have multiple monitors. A maximum of three viewports can be floating at the same time. 

Note: You cannot float a viewport if you are using the legacy Direct3D display driver. 

Procedures 

To toggle display of the home grid in the active viewport, do one of the following: 

 Click or right-click the General viewport label ([+]), and then click Show Grids. 

 Press G. 

To customize the General Viewport Label menu: 

1. From the Menu bar, choose Customize > Customize User Interface.... 

2. From the Custom User Interface dialog, click the Menu tab. 

3. From the Menu panel, click the drop-down menu on the top right and choose Viewport Menu Label 

Bar. 

4. In the Menu window, add and remove commands as required under Views - General Viewport Label 

Menu. 

 

Using specialized user interface tools. 

 

The Customize User Interface dialog lets you create an entirely customized user interface, including 

shortcuts, quad menus, menus, toolbars, and colors. You can also add commands and macro scripts by 

selecting either a text or icon button to represent the command or script on the toolbar. 

 Default menu: Customize menu > Customize User Interface 

 Alt menu: Customize menu > Customization > Customize User Interface 

Most commands in the 3ds Max interface appear in this dialog as actions. An action is simply a command 

that you can assign to a keyboard shortcut, toolbar, quad menu, or menu. The Keyboard, Toolbars, Quads, 

and Menus panels of this dialog show lists of actions that you can assign. The lists on the Colors panel 

contain UI elements instead. 

Note: A few actions do not correspond to any elements in the default user interface. For more 

information, see Additional Keyboard Commands. 

These are the file formats: 

 KBDX Stores custom keyboard-shortcut assignments. 

 MUSX Stores custom mouse settings. 



 CUIX Stores custom toolbar settings. 

 MNUX Stores custom menu settings (both quad menus and pull-down menus). 

 CLRX Stores custom color settings. 

Note: These file formats supersede the formats used in releases prior to 3ds Max 2013. 

 

The Keyboard panel lets you create your own keyboard shortcuts. You can assign shortcuts to 
most commands available in 3ds Max. 

 Default menu: Customize menu > Customize User Interface > Keyboard tab 

 Alt menu: Customize menu > Customization > Customize User Interface > Keyboard tab 

The same shortcuts can be assigned to multiple commands, as long as they occur in different 

contexts. For example, in Video Post, the shortcut Ctrl+S is assigned to Add Scene Event; 

however, in the Main UI, it is assigned to Save File. 

When you use a keyboard shortcut, 3ds Max looks for a context-specific shortcut first. If none is 
found it then looks for the appropriate command in the Main UI shortcuts. 

For the context-specific shortcuts to work properly, the Keyboard Shortcut Override toggle must 
be on (the default). If it is off, only the Main UI keyboard shortcuts are available. 
Customized mouse settings use the KBDX file format. The default settings are saved 
in defaultui.kbdx. (Prior to 3ds Max 2013, keyboard files had a file name extension of KBD. This 
format is now superseded.) 

When you choose Maya as the interaction mode, the shortcut settings are updated to behave in 
a manner compatible with Autodesk Maya. These settings are saved in defaultui.kbdx. These 
settings are saved in mayamodeui.kbdx, and choosing Maya mode copies them 
to defaultui.kbdx. Conversely, choosing 3ds Max mode copies the settings 
from maxmodeui.kbdx to defaultui.kbdx. 
The first time you start 3ds Max on your system, 3ds Max generates maxmodeui.kbdx based on 
the settings in the defaultui.kbdx file that ships with 3ds Max. 

Procedures 

To create a keyboard shortcut: 

1. Choose Customize menu  Customize User Interface  Keyboard panel. 

2. Use the Group and Category lists to find the action for which you want to create a shortcut. 

3. Click action in the Action list to highlight it. 

4. In the Hotkey field, enter the keyboard shortcut you want to assign to the action. 

Note: If the keyboard shortcut you enter is already assigned to an action, that action name appears in 

the Assigned To field. 

5. Click Assign. 

Interface 
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Group drop-down list 

Lets you select the context you want to customize, such as Main UI, Track View, Material Editor, 

and so on. 

Active 

Toggles availability of context-specific keyboard shortcuts. When on, you can use duplicate 

shortcut keys between contexts within the overall user interface. For example, A can be the 

shortcut for Angle Snap toggle within the Main UI, and also a shortcut for Assign Material to 

Selection when you are working in the Material Editor. When Active is off, the shortcuts defined 

for the appropriate context are not available. Default=on. 

Category drop-down list 

Lets you choose among categories of user interface actions for the chosen group. 

Action list 

Displays all the available actions and shortcuts, if defined, for the chosen group (context) and 

category. 

Hotkey field 



Lets you enter a keyboard shortcut. Once the shortcut is entered, the Assign Button is active. 

Assigned To 

Displays the action a shortcut is assigned to if the shortcut you entered is already assigned. 

Assign 

Becomes available when you enter a keyboard shortcut in the Hotkey field. When you click 

Assign, it transfers the shortcut information to the Action list on the left side of the dialog. 

Remove 

Removes all shortcuts for the selected action in the Action list on the left side of the dialog. 

Overrides Active 

When on, holding keys for boldface shortcuts in the Edit Poly and Editable Poly groups overrides 

standard functionality. For example, while editing an Editable Poly object at the Polygon sub-

object level, pressing and holding Shift+Ctrl+B activates the Bevel tool temporarily, 

overriding the current operation. 

Delay To Override 

The delay before which the active keyboard shortcut overrides the current operation (see 

Overrides Active, preceding). 

Write Keyboard Chart 

Opens the Save File As dialog, where you can save changes you made to keyboard shortcuts in a 

TXT file that you can print. 

Load 

Displays the Load Shortcut File dialog. Allows you to load custom shortcuts from a KBDX file 

into your 3ds Max interface. 

Save 

Displays the Save Shortcut File As dialog. Allows you to save any changes you’ve made to the 

shortcuts to a KBDX file. 

Reset 

Restores the shortcuts to the default setup (defaultui.kbdx). 
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ADD TO COLLECTION 

The Mouse panel lets you customize mouse behavior. 

 Default menu: Customize menu > Customize User Interface > Mouse tab 

 Alt menu: Customize menu > Customization > Customize User Interface > Mouse tab 

When you load, save, or reset customized mouse settings, 3ds Max uses the MUSX file format. The default 

settings are saved in defaultui.musx. 

When you choose Maya as the interaction mode, the mouse settings are updated to behave in a manner 

compatible with Autodesk Maya. These settings are saved in mayamodeui.musx, and choosing Maya mode 

copies them to defaultui.musx. Conversely, choosing 3ds Max mode copies the settings 

from maxmodeui.musx to defaultui.musx. 

Important: The mouse settings that affect Zoom and Pan in 3ds Max mode versus Maya mode 

(the three shortcut settings and the Zoom In direction) also affect the windows in Track View, the 

Motion Mixer, Motion Flow, the Edit UVWs dialog, and the expanded track bar ("Mini Curve 

Editor"). 

Interface 
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Category drop-down list 

Lets you choose among categories of user interface actions for the mouse. 

Action list 

Displays all the available actions and shortcuts, if defined, for the mouse. 

Note: "Arc Rotate" is also known as "Orbit." 

Shortcut field 

Lets you enter a keyboard shortcut. Once the shortcut is entered, the Assign Button is active. 

Assigned To 

Displays the action a shortcut is assigned to if the shortcut you entered is already assigned. 

Assign 

Becomes available when you enter a keyboard shortcut in the Hotkey field. When you click 

Assign, it transfers the shortcut information to the Action list on the left side of the dialog. 

Remove 



Removes all shortcuts for the selected action in the Action list on the left side of the dialog. 

Mouse Control group 

AutoFocus Viewport 

When on, pressing any key or mouse button while the mouse is over a viewport makes that 

viewport active. Default=on. 

This option provides compatibility with Autodesk Maya. When Maya is the active interaction 

mode, pressing spacebar while the mouse is over a viewport makes the viewport 

active and maximizes the viewport. 

Maya Mode Selection 

When on, Shift+mouse-click either adds to or subtracts from a selection set, 

while Ctrl+mouse-click subtracts from a selection. Default=off. 

This option provides compatibility with Autodesk Maya. 

Lock Orbit in orthographic views 

When on, Orbit is locked and unavailable in orthographic viewports. Default=off. 

This option provides compatibility with Autodesk Maya. 

Zoom About Mouse Point (Orthographic) 

When on, viewports zoom about the point where you click the mouse. When off, viewports zoom 

about the center of the view. Applies to orthographic viewports only. Default=on. 

Zoom About Mouse Point (Perspective) 

When on, viewports zoom about the point where you click the mouse. When off, viewports zoom 

about the center of the view. Applies to perspective viewports only. Default=on. 

Right Click Menu Over Selected Only 

Limits the right-click menu display over a selected object. Default=off. 

When this option is off, you can right-click anywhere in the viewports to display a menu. 

Use Middle Mouse Button for Stroke 

When on, assigns command shortcuts to stroke patterns applied by dragging with the middle 

mouse button. See Strokes. Default=off. 

When off, the middle mouse button pans the viewport. To zoom with a three-button mouse, hold 

down Ctrl+Alt and drag the middle mouse button (does not work for Camera views). 

Note: When Maya mode is active, Alt + the middle mouse button pans the viewport and Alt + 

the right mouse button zooms it. (This Zoom shortcut does not work for Camera views.) 

Wheel Zoom Increment 
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Determines the sensitivity of the zoom when you use the wheel on the mouse. Increase sensitivity 

up to a maximum value of 100 or reduce it to a minimum of 0.01. Default=1.0. 

Zoom In Mouse Action Direction 

Use the drop-down list to choose the direction in which dragging the mouse 

zooms in while Zoom is active. Default=up. 

This option provides compatibility with Autodesk Maya. 

Load 

Displays the Load Shortcut File dialog. Allows you to load custom shortcuts from an MUSX file 

into your 3ds Max interface. 

Save 

Displays the Save Shortcut File As dialog. Allows you to save any changes you’ve made to the 

shortcuts to an MUSX file. 

Reset 

Restores the shortcuts to the default setup ( defaultui.musx). 

Toolbars Panel 

The Toolbars panel lets you edit existing toolbars and create your own custom toolbars. You can 
add, remove, and edit buttons on existing toolbars, or you can delete the toolbars entirely. You 
can also create custom toolbars with both 3ds Max commands and scripts. 

 Default menu: Customize menu > Customize User Interface > Toolbars tab 

 Alt menu: Customize menu > Customization > Customize User Interface > Toolbars tab 

Customized toolbar settings use the CUIX file format. (Prior to 3ds Max 2013, keyboard files had 
a file name extension of CUI. This format is now superseded.) 

Procedures 

To create and populate a toolbar: 

1. Open the Customize User Interface dialog and go to the Toolbars tab. 

2. Click New. 

The New Toolbar dialog appears. 

3. Enter a name for the new toolbar and click OK. 

The new toolbar appears as a small floater. Like any floating toolbar, you can resize it and change 

proportions by dragging the corners and edges. 

4. Use any of these three methods to add commands to the toolbar: 

 Drag a command to the toolbar from the Customize User Interface dialog  Action list. If the 

action has a default icon assigned to it (it appears next to the command in the action list), the icon 

will appear as a button on your toolbar. If no icon is assigned to the command, the name of the 

command will appear as a button on the toolbar. 
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 To copy an existing button, Ctrl+drag the button from any toolbar onto your toolbar. 

 To move an existing button, Alt+drag the button from any toolbar onto your toolbar. 

5. If you don’t want the new toolbar to appear in the interface by default, choose it from the drop-down 

list on the right side of the Customize User Interface dialog, and then turn on the Hide checkbox. 

Thereafter you can toggle the custom toolbar by right-clicking a blank area of any toolbar and 

choosing the toolbar name from the context menu. 

To add commands to a toolbar: 

1. Open the Customize User Interface dialog and go to the Toolbars tab. 

Alternatively, right-click the label of a toolbar and then choose Customize. 

2. If necessary, open the toolbar to customize using either of the following methods: 

 Right-click a blank area of any toolbar and choose the toolbar name from the context menu. 

 Choose the toolbar name from the toolbars drop-down list on the right side of the dialog and then 

turn off the Hide checkbox. 

3. Use any of these three methods to add commands to the toolbar: 

 Drag a command to the toolbar from the Customize User Interface dialog  Action list. If the 

action has a default icon assigned to it (it appears next to the command in the action list), the icon 

will appear as a button on your toolbar. If no icon is assigned to the command, the name of the 

command will appear as a button on the toolbar. 

 To copy an existing button, Ctrl+drag the button from any toolbar onto your toolbar. 

 To move an existing button, Alt+drag the button from any toolbar onto your toolbar. 

To record a script and add it to a toolbar: 

Use this method to record a series of commands into a MAXScript command sequence and then turn 

the script into a toolbar button. You can then re-invoke that sequence at any time. No scripting 

knowledge is necessary. 

1. Open the Customize User Interface dialog and go to the Toolbars tab. 

Alternatively, right-click the label of a toolbar and then choose Customize. 

2. Open a MAXScript Listener window by any of the following methods: 

 Press F11. 

 Choose MAXScript menu  MAXScript Listener. 

 Choose  Utilities panel  MAXScript  MAXScript rollout  Open Listener. 

 Click or right-click the POV viewport label, and then from the POV viewport label menu, choose 

Extended Viewports  MAXScript Listener. 

3. Choose MAXScript menu  Macro Recorder, or, from on the Listener dialog, choose 

MacroRecorder  Enable. 

4. Perform the actions you want to record. 

The Macro Recorder records the actions you perform as a script in the upper portion of the Listener 

dialog (pink background). 

5. Highlight the lines you want in the recorded script, and then drag those lines directly onto a toolbar. 
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Note: Your macro might require some minor editing to remove extraneous steps or to refine the 

procedure. 

You can edit the appearance of the text or icons on your toolbars with Edit Button Appearance, which is 

available when you right-click the toolbar button. 

To add a button to the Main toolbar: 

 Drag an action from the Action list and drop it on the list in the Main Toolbar group. 

The toolbar updates to show the new button. If the action you chose doesn’t have an associated icon, a 

generic button appears on the toolbar. See Edit Button Appearance Dialog. 

To remove a button from the toolbar: 

1. Click an item in the Main toolbar list to highlight it. 

2. Click Remove. 

3ds Max removes the button from the list and the Main toolbar. 

Interface 

 

Group drop-down list 

Lets you choose the functional context you want to customize. Contexts include Main UI (user 

interface), Track View, and Material Editor. 
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Category drop-down list 

Lets you choose among categories of user-interface actions for the chosen group. 

Action list 

Displays all available actions for the chosen group and category. 

[toolbars drop-down list] 

Lets you choose among existing toolbars (aside from the main toolbar, which is not customizable. 

New 

Opens the New Toolbar dialog. Enter the name of the toolbar you want to create and click OK. 

The new toolbar appears as a small floater. 

Once you’ve created a toolbar, there are three ways to add commands: 

 Drag actions from the Action Window in the Toolbars panel of the Customize User Interface 

dialog onto your toolbar. 

 Ctrl+drag buttons from any toolbar onto your toolbar. This action creates a copy of the 

button on your toolbar. 

 Alt+drag buttons from any toolbar onto your toolbar. This action moves the button from the 

original toolbar onto your toolbar. 

Delete 

Deletes the toolbar item displayed in the Toolbars list. 

Rename 

Displays the Rename Toolbar dialog. Select a toolbar from the Toolbars list to activate the 

Rename button. Click Rename, change the name of the toolbar, and click OK. The toolbar name 

changes in the toolbar floater. 

Hide 

Toggles 3ds Max window display of the toolbar that is chosen in the toolbars list. 

Load 

Displays the Load UI File dialog. Allows you to load custom user interface (CUIX) files. 

Save 

Displays the Save UI File As dialog. Allows you to save any changes to the user interface in a 

CUIX file. 

Reset 

Restores the default setup (defaultUI.cuix). 

The Quads panel lets you customize the quad menus. You can create your own quad menu sets, or you can 

edit existing sets. In the Quads panel, you can customize menu labels, functionality, layout, and shortcuts. 
The advanced quad menu options let you modify the color and behavior of the quad menu system. You can 

also save and load custom menu sets. 
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 Default menu: Customize menu > Customize User Interface > Quads tab 

 Alt menu: Customize menu > Customization > Customize User Interface > Quads tab 

Customized quad menu settings use the MNUX file format. (Prior to 3ds Max 2013, menu files had a file 

name extension of MNU. This format is now superseded.) 

Procedures 

To create a quad set: 

1. Choose Customize menu  Customize User Interface  Quads tab. 

2. Click New. 

The New Quad Set dialog appears. 

3. Enter the name of the quad set and click OK. 

The new set appears in the Quad set list. 

To add a command to a quad set: 

1. Choose Customize menu  Customize User Interface  Quads tab. 

2. Choose the quad set you want to edit from the upper-right drop-down list. 

If you want to change the name of the quad set, click Rename and enter a new name in the Rename 

Quad Set dialog. 

3. Select the quadrant where you want to place the command. 

You can edit the name of the quadrant by changing the text in the Label area. 

4. Choose the appropriate Group and Category from the respective drop-down lists. 

5. Choose a command from the action list and drag it into the Quad Menu window. 

Use the same procedure to add menus and separators to your quad set. 

To delete a quad set: 

Note: You cannot delete any of the default quad sets. 

1. Choose Customize menu  Customize User Interface  Quads tab. 

2. Choose the quad set you want to delete from the upper-right drop-down list. 

3. Click Delete. 

To remove a command from a quad set: 

1. Choose Customize menu  Customize User Interface  Quads tab. 

2. Choose the quad set you want to edit from the upper-right drop-down list. 

3. Choose the command you want to remove. 

4. Click the Delete button. 

Use the same procedure to remove menus and separators from your quad set. 

To move a command in a quad set: 



 Choose the command in the quad set list and drag it to a new position in the list. 

Interface 

 

Group drop-down list 

Lets you select the context you want to customize, such as Main UI, Track View, Material Editor, 

and so on. 

Category drop-down list 

Lets you choose among categories of user interface actions for the chosen context. 

Action list 

Displays all the available actions for the chosen group and category. To add an action to a specific 

quad set, select it and drag it to the quad menu window on the right side of this dialog. Right-click 

an action in this window to edit the macro script that defines the action (if there is one). 

Separator list 



Displays a separator line that you can use to separate groups of menu items in a quadrant. To add a 

separator line to a specific quad set, select it and drag it to the quad menu window on the right side 

of this dialog. 

Menus list 

Displays the names of all 3ds Max menus. To add a menu to a specific quad set, select it and drag 

it to the quad menu window on the right side of this dialog. Right-click a menu in this window to 

delete the menu, rename it, or create a new, empty menu. 

[quad set drop-down list] 

Displays the available quad sets. 

Additional Quad Menus appear in this list. They can be edited, renamed, and reorganized; 

however, they cannot be deleted. 

New 

Opens the New Quad Set dialog. Enter the name of the quad set you want to create and click OK. 

The new quad set appears in the Quad set list. 

Delete 

Deletes the item displayed in the Quad set list. Available only for user-generated quad sets. 

Rename 

Opens the Rename Quad Set dialog. To activate the Rename button, choose a quad set from the 

list. To change the name, click Rename, edit the name of the quad set, and then click OK. 

Quad Shortcut 

Allows you to define a keyboard shortcut for displaying the quad set. Enter the shortcut and click 

Assign to make the change. 

Show All Quads 

When on, the keyboard shortcut shows all four quadrants of the quad menu. When off, the 

keyboard shortcut shows only one quadrant at a time. 

Label 

Displays the label for the highlighted quadrant (shown in yellow to the left of the Label). 

[quad menu window] 

Displays the menu options for the currently selected quad menu and quad set. To add menus and 

commands, drag options from the Action and Menus windows to this window. 

Items included in the quad menu are displayed only when they are available. For example, if your 

quad menu contains Track View Selected, the command will display only if a selection exists 

when you open the quad menu. if none of the commands are available when you open the quad 

menu, the quadrant does not appear. 

When you right-click an item in the quad menu window, several actions become available: 
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 Delete Menu Item Removes the highlighted action, separator, or menu from the quad menu. 

 Edit Menu Item Name Opens the Edit Menu Item Name dialog. To edit the name, the 

Customize Name checkbox must be on. Enter the desired name in the name text field and 

click OK. The item name is changed in the quad menu, but not in the quad menu window. 

 Flatten Sub-Menu Displays contents of the highlighted submenu at the top level of the quad. 

If you choose this item, the menu name is followed by the string: "[FLAT]". 

 Edit MacroScript Opens the MacroScript for the highlighted action in a MAXScript editor 

window. 

Advanced Options 

Opens the Advanced Quad Menu Options dialog. 

Load 

Displays the Load Menu File dialog. Allows you to load custom menu (MNUX) files into the 3ds 

Max interface. 

Save 

Displays the Save Menu File As dialog. Allows you to save changes to the quad menus in a 

MNUX file. 

Reset 

Restores the default setup (defaultui.mnux). 

The Menus panel lets you customize the menus in 3ds Max. You can edit existing menus or 
create your own. You can customize menu labels, functionality, and layout. 

 Default menu: Customize menu > Customize User Interface > Menus tab 

 Alt menu: Customize menu > Customization > Customize User Interface > Menus tab 

Customized menu settings use the MNUX file format. (Prior to 3ds Max 2013, menu files had a 
file name extension of MNU. This format is now superseded.) 

Procedures 

To create a menu: 

1. Open the Customize User Interface dialog to the Menus panel. 

2. Click New. 

The New Menu dialog appears. 

3. Enter the name of the menu, and click OK. 

The new menu appears in the menu list. 

To add a command to a menu: 

1. Open the Customize User Interface dialog to the Menus panel. 

2. Choose the menu you want to edit from the drop-down list. 

If you want to change the name of the menu, click Rename, and enter a new name in the Rename 

Menu dialog. 

https://knowledge.autodesk.com/support/3ds-max/learn-explore/caas/CloudHelp/cloudhelp/2019/ENU/3DSMax-Customizing/files/GUID-27D9732A-8CB1-452D-92D6-04A72A3639BF-htm.html#GUID-27D9732A-8CB1-452D-92D6-04A72A3639BF


3. Choose the appropriate Group and Category from the respective drop-down lists. 

4. Choose a command from the action list and drag it into the Menu window. 

Use the same procedure to add menus and separators to your menu. 

To delete a menu: 

1. Open the Customize User Interface dialog to the Menus panel. 

2. Choose the menu you want to delete from the drop-down list. 

3. Click Delete. 

To remove a command from a menu: 

1. Open the Customize User Interface dialog to the Menus panel. 

2. Choose the menu you want to edit from the drop-down list. 

3. Choose the command you want to remove. 

4. Press Delete. 

Use the same procedure to remove menus and separators from your menus. 

To move a command in a menu: 

 Choose the command in the menu window and drag it to a new position in the window. 

Interface 

 

Group drop-down list 



Lets you select the context you want to customize, such as: Main UI, Track View, Material Editor, 

and so on. 

Category drop-down list 

Lets you choose among categories of user interface actions for the chosen context. 

Action list 

Displays all the available actions for the chosen group and category. To add an action to a specific 

menu, select it and drag it to the menu window on the right side of this dialog. Right-click an 

action in this window to edit the macro script that defines this action (if there is one). 

Separator list 

Displays a separator line that can be used to separate groups of menu items. To add a separator to 

a specific menu, select it and drag it to the menu window on the right side of this dialog. 

Menus list 

Displays the names of all menus. To add a menu to another menu (shown in the Menu List), select 

and drag it to the menu window on the right side of this dialog. Right-click an entry in this list to 

delete the menu, rename it, or create a new, empty menu. 

[menus drop-down list] 

Lists all available menus. To edit a menu, choose it from the list; this makes its contents available 

for editing in the menu window below it (see following). 

The default item is Main Menu Bar. 

New 

Opens the New Menu dialog. Enter the name of the menu you want to create and click OK. The 

new menu appears in the menu window on the left side of the dialog as well as in the Menu List. 

Delete 

Deletes the item highlighted in the menu list window below. 

Rename 

Opens the Edit Menu Item Name dialog. Select an item in the menu list window and click 

Rename. This dialog lets you specify a custom name to be displayed in the menu. If you precede a 

letter in the custom name with the “&” (ampersand) character, that letter is used as a menu 

accelerator. 

[menu window] 

Displays the entries for the menu currently chosen in the menus drop-down list. To add menus and 

commands (actions), simply select and drag the options from the Action and Menus lists to this 

window. 

Several actions become available when you right-click any item in the menu window: 

 Delete Menu Item Removes the highlighted action, separator, or menu from the menu. 



 Edit Menu Item Name Opens the Edit Menu Item Name dialog. The Customize Name 

checkbox must be on to edit the name. Enter the desired name in the Name text field and 

press OK. 

Changing a menu item name updates its menu entry, but the original name remains in the 

menu window. Also, if you precede a letter in the custom name with the “&” (ampersand) 

character, that letter is used as a menu accelerator. 

 Edit Menu Item Icon Opens a file dialog that lets you choose a PNG image to use as the icon 

for this menu item. 

Note: The assigned icon appears on the menu only when the Alt menu system is active. 

 Flatten Sub-Menu Displays contents of the highlighted submenu at the top level of the 

menu. If you choose this item, the menu name is followed by the string: "[FLAT]". 

 Edit MacroScript Opens the script for the highlighted action in a MAXScript editor window. 

Load 

Displays the Load Menu File dialog. Allows you to load custom menu (MNUX) files into the 3ds 

Max interface. 

Save 

Displays the Save Menu File As dialog. Allows you to save changes to the menus in an MNUX 

file. 

Note: Quad menu customizations also use MNUX files. 

The Colors panel of the Customize User Interface dialog allows you to customize the look of 
the 3ds Max interface. You can adjust the colors for almost every element in the interface, giving 
you the freedom to design your own unique style. 

 Default menu: Customize menu > Customize User Interface > Colors tab 

 Customize menu > Customization > Customize User Interface > Colors tab 

The quad menu colors cannot be customized from the Color panel. To customize quad menu 
colors, use the Advanced Quad Menu Options dialog. 

Customized color settings use the CLRX file format. (Prior to 3ds Max 2013, color files had a file 
name extension of CLR. This format is now superseded.) 

Procedures 

To change an interface element color: 

1. Open the Customize User Interface dialog to the Colors panel. 

2. From the Elements drop-down list, choose the category of the interface element whose color you 

intend to change. 

3. In the list below the Elements field, highlight the element whose color you intend to change. 

The Color swatch shows the current color of the element. 

4. Click the Color swatch and then use the Color Selector dialog to choose a new color. Click the Close 

button to set the color. 

To restore the color that was active at the time that you opened the dialog, highlight the element and 

click Reset. 

https://knowledge.autodesk.com/support/3ds-max/learn-explore/caas/CloudHelp/cloudhelp/2019/ENU/3DSMax-Basics/files/GUID-90D08333-ADB3-4E8C-9579-1A0A71985604-htm.html
https://knowledge.autodesk.com/support/3ds-max/learn-explore/caas/CloudHelp/cloudhelp/2019/ENU/3DSMax-Customizing/files/GUID-A1D1C3D4-3E7A-4269-8399-A9E5A9C9FEFF-htm.html#GUID-A1D1C3D4-3E7A-4269-8399-A9E5A9C9FEFF


5. Continue choosing elements and changing colors as necessary. 

6. To finish and apply the color changes to the interface, close the dialog by clicking the X button in the 

upper-right corner. 

Tip: If you change several colors and then want to restore all colors to the default values, click 
the Load button and open DefaultUI.clr. 

Interface 

 
Elements drop-down list 

Lets you select from the various high-level groupings: Character, Geometry, Gizmos, Viewports, 

and more. 

[UI elements list] 

Lets you chose an element in the active group. After doing so, its color appears to the right of the 

list; click the swatch to change the element's color. 

The viewport elements Viewport Background Gradient Bottom and Viewport Background 

Gradient Top provide the colors for viewports with gradient backgrounds. This option is the 

default for Perspective viewports. 

General UI Colors list 

Displays all the elements in the user interface that can be changed. After you click an element, its 

color appears to the right of the list; click the swatch to change the element's color. 

Color 



Displays the color for the selected category and element. Click to display the Color Selector, 

where you can change the color. After choosing a new color, click Apply Colors Now to make the 

change in the interface. 

Reset 

Resets the color of the highlighted element to the value that was active when you opened the 

dialog. 

Intensity 

Sets a grayscale value for the display of the grid lines. 0 is black and 255 is white. 

This control is available only when you choose the Set By Intensity option from the Grids 

element, and affects the intensity of the grid lines in the viewports. 

Invert 
Inverts the grayscale value for the display of grid lines. Dark gray becomes light gray and vice-

versa. 

This control is available only when you choose the Set By Intensity option from the Grids 

element. 

Theme 
Sets the background color of the Graphite Modeling Tools interface elements. Choose Light or 

Dark from the drop-down list. 

Normal Color 
Displays the color for the selected item. Click to display the Color Selector dialog, where you can 

change the color. After choosing a new color, click Apply to make the change in the interface. 

Disabled Color 
Sets the color for when the selected item is disabled in the UI. 

This control is only available for specific items in the General UI Colors list. 

Hover Color 

Sets the color for the selected item when hovering over it. 

This control is only available for specific items in the General UI Colors list. 

Reset 

Restores the highlighted item to its color when you first opened the dialog. 

Apply Colors Now 

Activates any changes in the user interface. 

Load 
Displays the Load Color File dialog. Allows you to load custom color (CLRX) files to use in 

the 3ds Max interface. 

Save 
Displays the Save Color File As dialog. Lets you save changes to the user interface colors in a 

CLRX file. 

Reset 

Restores the default setup (defaultui.clrx). 
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